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Support Center
• Overview, page 1

Overview
WebEx Support Center provides a variety of tools that you can use to provide remote support to customers:
• Remote Support, on page 3 Remotely diagnose problems, transfer files, and resolve issues for customers.
Show customers how to use applications or control their computers. Transfer files to and from a customer
computers to analyze them or install updates or patches.
• Remote Access, on page 9 Use this optional module outside support sessions to access, diagnose, and
work with computers remotely. Troubleshoot and maintain remote equipment even when the customer
is not at the computer.
• WebACD, on page 13 Give your customers anytime, anywhere access to your agents by adding a
"click-toconnect" link on your web site, desktop, product, or email signature. You can even customize
the request form to collect information you need and make it look like your Website. Use the WebACD
Inbox and Monitor to manage customer requests and CSRs.
• System Management, on page 17 This optional module is a Web-based console that you can use to
remotely manage network assets such as computers, servers, printers, and routers. Distribute software
packages and patches, view asset details, send messages to assets, manage software licenses, and generate
reports about asset information and status.
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Remote Support
• Getting Started, page 3
• Hosting and Joining Remote Support Sessions, page 4
• Sharing Applications and Desktops, page 5
• Other Questions, page 5

Getting Started
• What do I need to start or attend Remote Support sessions?
• Can I use Remote Support if I do not have Windows administrator privileges?
• Which video cameras do you recommend?

What do I need to start or attend Remote Support sessions?
To use Remote Support you will need a user account; if you do not have one, ask your site administrator to
set one up for you. Then download Remote Support from the Support page of your Support Center service
site.
For a detailed list of the computers, operating systems, and browsers that work with WebEx Remote Support,
see "System Requirements"Support Center Release Notes.

Note

To start or attend fully interactive Remote Support sessions on Asian versions of WebEx Remote Support
(Japanese, Korean, Traditional Chinese, and Simplified Chinese), you will also need a localized version
of Windows.

Can I use Remote Support if I do not have Windows administrator privileges?
Yes.
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Which video cameras do you recommend?
Most PC-compatible cameras should work with WebEx. For more information about video support, see
"Video" in the Meeting Center Release Notes.

Hosting and Joining Remote Support Sessions
• How can I invite customers to attend Remote Support sessions?
• Can I start WebEx Remote Support sessions directly from my ticket management console?
• What hot keys can my customer use during sessions?
• Can I automatically end inactive Remote Support sessions?

How can I invite customers to attend Remote Support sessions?
You can invite customers:
• From your CSR console
• From the Remote Support home page
• By pasting a link for the support session in an IM or email message
If your site administrator has enabled the WebACD component, you can also place a form on your website
that customers can use to request assistance. For more information, see the Support Center Release Notes.
Can I start WebEx Remote Support sessions directly from my ticket management console?
Yes. We offer out-of-the-box solutions, such as the supportforce.com and Remedy helpdesk system integrations,
and APIs that you can use to build a custom solutions. Contact your WebEx representative or go to the WebEx
developer's site, http://developers.webex.com for information about our APIs.
What hot keys can my customer use during sessions?
Hot keys are keyboard shortcuts customers can use to quickly carry out a function. Customers can use the
following hot keys:
• Leave session: Ctrl + F10
• Start chat session: Ctrl + F8
• Close the chat window: Ctrl + F3
• End file transfer session: Ctrl + F7
• Close the application or desktop sharing windows: Ctrl + F9
• Bring the chat window to the foreground: Ctrl+Shift+F3
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Can I automatically end inactive Remote Support sessions?
Yes. WebEx site administrators can set an option on the Site Administration page to automatically end inactive
sessions. When a session is inactive for the specified period of time, a warning message appears so that CSRs
can choose to continue the session or allow it to automatically end. For more information and detailed
instructions, see the WebEx Site Administration guide on the Support page of your Support Center service
site.

Sharing Applications and Desktops
• What types of files and applications can I view or control in Remote Support sessions?
• Do I need to have the application that I want to view or control on my computer?
• What happens if my customer's screen uses a different resolution than mine?
• Why do I sometimes see a yellow cross-hatched pattern when viewing a customer's application?

What types of files and applications can I view or control in Remote Support sessions?
You can view or control almost any application that runs on your customer's computer.
Do I need to have the application that I want to view or control on my computer?
No.
What happens if my customer's screen uses a different resolution than mine?
Remote Support can appropriately display your customer's desktop or application even if the resolution on
your computer is different. For best results, set your monitor to 800 x 600 pixels.
Why do I sometimes see a yellow cross-hatched pattern when viewing a customer's application?
The cross-hatched pattern is the shadow of a window that is covering the application on your customer's
screen. Ask your customer to close the window and the pattern will disappear.

Other Questions
• How can I improve the performance of my Remote Support sessions?
• How can I test performance?
• What's the best way to ensure auditing compliance?
• What's the best way to gather diagnostic system information from customer computers?
• Why can't I bookmark certain pages on my WebEx site?
• Can I set email notifications to show the meeting time in the attendee's time zone?
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• Where can I find the global call-in numbers?
• Can users change their language, time zone, and locale settings?
• Can I access the WebEx community from my WebEx service Web site?

How can I improve the performance of my Remote Support sessions?
Some of the factors that affect performance include:
• The speed of your computer's Internet connection
• Internet traffic
• Performance of your firewall and proxy servers
Although you may have a high-speed connection to the Internet, there may be congestion or packet loss on
the Internet. You usually can't do much about it other than to inform your network administrator or Internet
service provider. Congestion is often transient and resolves itself over time. You should, however, report
serious or persistent problems.
How can I test performance?
Use a route tracing utility, such as Trace Route, to determine where problems are exist between your computer
and the WebEx servers. The utility sends data from your computer and measures the time it takes to for the
data to reach the WebEx server. Ideally, data should take between 1-60 ms to reach the server. If it takes
between 60-100 ms, your connection is slow. Times longer than 100 ms are unacceptably slow. If you continue
to experience poor performance, contact your network administrator.
To run Trace Route on Windows, open a command prompt and then enter "tracert your_site_URL" (where
"your_site_URL" is the address of your WebEx service site). Make sure that you place a space after "tracert".
What's the best way to ensure auditing compliance?
To ensure auditing compliance WebEx site administrators can:
• Place disclaimer text on your Remote Support pre-session form
• Enable the option in the WebEx Site Administrator to automatically record all Remote Support sessions
• Review the Remote Support event log to see CSR actions during support sessions
What's the best way to gather diagnostic system information from customer computers?
From the CSR console, select the option to collect customer system information. You can then save the
information and upload it to your ticket management system. This way, system information gathered by first
level CSRs is automatically available to second and third level CSRs.
Why can't I bookmark certain pages on my WebEx site?
Your Meeting Center service Web site dynamically generates many of its pages so you cannot bookmark
them. You can, however, bookmark the following pages on your WebEx service site:
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URL

Description

<sitename>.webex.com

The home page for your WebEx service site.

<sitename>.webex.com/meet/<username>

Your Personal Meeting Room page, which shows
online sessions that you scheduled and any in-progress
meetings that you are currently hosting. You can
provide this URL to a user in an email, and you can
print it on your business cards. Users who view this
page can join any meeting that you are hosting or
download your shared files and folders.
In the My WebEx > My Profile page, you can specify
options for your Personal Meeting Room page, such
as including a welcome message, graphics, and links
to files and folders that you want to share.

Can I set email notifications to show the meeting time in the attendee's time zone?
Yes. For better ease-of-use for global attendees, you can invite attendees in their own language and time zone.
The invitation displays the meeting time in the attendee's time zone, and the meeting link in the invitation
displays meeting information in the attendee's language and allows the attendee to join the meeting in their
own language. This option is available only when scheduling on Web pages.
The host's settings for language and time zone are used by default. When inviting an attendee from an address
book, stored settings for language and time zone are used. Any attendee's language and time zone can be
overridden by the host when inviting the attendee.
Where can I find the global call-in numbers?
If your site has WebEx audio turned on, and if your site also has the Global Call-in Numbers option turned
on, you can view or display the global call-in numbers in two ways:
• In My WebEx, select My Audio. Under Personal Conference Number, select the Show all global call-in
numbers link.
• When you are scheduling a meeting, under Audio Conference Settings, turn on the Display global call-in
numbers option. This option provides a link to the list of numbers—such as toll-free or local
numbers—that attendees in other countries can call to connect to audio.
For information about global toll-free calling restrictions, go to
http://www.webex.com/pdf/tollfree_restrictions.pdf.
Can users change their language, time zone, and locale settings?
Yes. Calendar pages, meeting information pages, Join pages, and email invitations now display links that
allow users to easily change their language, time zone, and locale settings.
Can I access the WebEx community from my WebEx service Web site?
Yes. The Community button appears on the horizontal navigation bar, allowing both hosts and attendees to
access the WebEx Community in a new browser window.
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Getting Started
• What do I need to use WebEx Remote Access?
• Do I have to be an administrator to install the Remote Access agent on a remote computer?
• What's the most efficient way to install Remote Access on hundreds of computers?
• What's the best way to add computers to my WebEx Remote Access network?

What do I need to use WebEx Remote Access?
You will need to download the Support Manager client from the Downloads section of your Support page.
For a detailed list of the computers, operating systems, and browsers that work with Remote Access, see
"System Requirements" in the Support Center Release Notes.
Do I have to be an administrator to install the Remote Access agent on a remote computer?
Yes.
What's the most efficient way to install Remote Access on hundreds of computers?
The most efficient way is to use a silent installer and an IT software distribution package such WebEx System
Management. For more information about "System Management", see "Video" in the Meeting Center Release
Notes.
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What's the best way to add computers to my WebEx Remote Access network?
You can:
• Create groups and sub-groups of computers and then add all computers in the group instead of adding
computers individually. For detailed instructions, see the WebEx Site Administration Guide on the
Support page of your Support Center service site.
• Use a silent installer with an IT software distribution package such WebEx System Management. For
more information about "System Management", see Support Center Release Notes.

Connecting and Working with Remote Computers
• How do I access a remote computer?
• Do I need to have the application on my computer that I want to access?

How do I access a remote computer?
First install the WebEx Remote Access agent on the remote computer; the remote computer automatically
becomes part of your Remote Access remote network. For detailed instructions, see the Remote Access guide
on the Support page of your Support Center service site.
Do I need to have the application on my computer that I want to access?
No.

Security
• Can I prevent someone who is standing by a remote computer from seeing my actions on the computer's
monitor?
• Can I prevent somebody from using a remote computer while I am working on it?
• When a Remote Access session ends, can I automatically lock the remote computer to prevent
unauthorized access?
• Can I automatically end inactive sessions?
• Can I receive notification whenever a computer is accessed by remote user?
• Can I change the access code or phone authentication rules on the remote computer?
• Can I limit access to my Remote Access network computers to a specific range of IP address in my
subnet?
• When I access a remote computer, can I change session options on the remote computer?
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Can I prevent someone who is standing by a remote computer from seeing my actions on the computer's
monitor?
Yes. Just enable the "Blank out this computers screen when in session" option to prevent your actions from
showing on the remote computer's monitor. You can also select an option to disable the remote computer's
keyboard and mouse.
Can I prevent somebody from using a remote computer while I am working on it?
Yes. Select the "Block this computer" option to prevent others from using the computer.
When a Remote Access session ends, can I automatically lock the remote computer to prevent unauthorized
access?
Yes. Just select the "Lock this computer at end of session" option.
Can I automatically end inactive sessions?
Yes. You can also specify time after which a session is considered to be inactive.
Can I receive notification whenever a computer is accessed by remote user?
Yes. An event log that shows everything that happened during the remote session is emailed to you after the
computer is remotely accessed. The log can also be sent to one or more email addresses that you specify.
Can I change the access code or phone authentication rules on the remote computer?
Yes. Site administrators can change codes and rules on remote computers.
Can I limit access to my Remote Access network computers to a specific range of IP address in my subnet?
Yes. Site administrators can specify a range of valid IP addresses. For detailed instructions, see the Site
Administrator guide on the Support page of your Support Center service site.
When I access a remote computer, can I change session options on the remote computer?
Yes. You can change them if your site administrator enables the option to allow session option changes for
certain computers or CSRs.

Other Questions
• What affects the performance of my remote access sessions?
• How can I test performance?
• Can users change their language, time zone, and locale settings?
• Can I access the WebEx community from my WebEx service Web site?
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What affects the performance of my remote access sessions?
Some of the factors that affect performance include:
• The speed of your computer's Internet connection
• Your Internet service provider
• Internet traffic
• Performance of firewall and proxy servers, if your computer is behind a company firewall
How can I test performance?
Use a route tracing utility, such as Trace Route, to determine where problems are exist between your computer
and the WebEx servers. These utilities send data from your computer and measures the time it takes to for
the packets to reach the WebEx server. Ideally, packets should take between 1-60 ms to reach the server. If
they take between 60-100 ms, your connection is slow; times longer than 100 ms are unacceptably slow. If
you continue to experience poor performance, contact your network administrator.
To run Trace Route on Windows, open a command prompt and then enter "tracert your_site_URL" (where
"your_site_URL" is the address of your WebEx service site). Make sure that you place a space after "tracert".
Can users change their language, time zone, and locale settings?
Yes. Calendar pages, session information pages, Join pages, and email invitations now display links that allow
users to easily change their language, time zone, and locale settings.
Can I access the WebEx community from my WebEx service Web site?
Yes. The Community button appears on the horizontal navigation bar, allowing both hosts and attendees to
access the WebEx Community in a new browser window.
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Getting Started
• What do I need to use WebACD?
• How can I download and install WebACD on my computer?

What do I need to use WebACD?
You will need a computer with Windows and a user account (see your Support Center site administrator for
assistance). Then download and install WebACD from the Support page of your Support Center service site.
There are two WebACD components, the WebACD Inbox and WebACD Monitor; your site administrator
can tell you which components to install.
How can I download and install WebACD on my computer?
To download and install WebACD:
1
2
3
4
5

Go to your WebEx Support Center Web site.
On the left navigation bar, under Assistance, select Support.
On the Support page, scroll down to the Downloads section.
Select the WebACD component you want to install; choose from WebACD Inbox and WebACD Monitor.
Follow the installation instructions.
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Managing Customer Session and Interactions
• Can I allow customers to request support from my website?
• Can I track customer requests that come in after business hours and then respond to them during business
hours?
• Can I invite a manager or another CSR to a remote support session with my customer?
• Can I send my customers an email that contains a link to my personal queue?

Can I allow customers to request support from my website?
Yes. You can place a help link or button on your website. For details, see the Site Administrator guide on the
Support page of your Support Center service site.
Can I track customer requests that come in after business hours and then respond to them during business
hours?
Yes. Just specify your business hours, then customers who submit requests during non-business hours will
be asked to leave a message. The information the customer puts on the "Leave a Message" form is sent to the
queue so that it can be handled during business hours.
Can I invite a manager or another CSR to a remote support session with my customer?
Yes. For details, see the WebACD Inbox Guide, available on the Support page or your Support Center service
site.
Can I send my customers an email that contains a link to my personal queue?
Yes. Just select the Copy Personal Queue URL on your console's Inbox menu and then add it to the email
signature section of your email template or message. Customers can then select the link in the email message
to automatically go to your personal queue.

Managing the Queue
• Is it possible to route customer requests for specific products to specific CSRs?
• Can I specify the WebACD queue hours of operation?
• Can CSRs decide which customer requests they want to handle?
• If there is sudden increase in requests, can I shut the queue down and display a message to customers?
• Can I have WebACD notify me when customers are assigned to me?
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Is it possible to route customer requests for specific products to specific CSRs?
Yes. WebACD provides skill-based routing to CSRs. For details, see the Site Administrator guide on the
Support page of your Support Center service site.
Can I specify the WebACD queue hours of operation?
Yes. For details, see the Site Administrator guide on the Support page of your Support Center service site.
Can CSRs decide which customer requests they want to handle?
Yes. When you create queues, just select the "Allow users to choose specific customers in the queue" option.
If there is sudden increase in requests, can I shut the queue down and display a message to customers?
Yes. You can specify the maximum number of customer requests that the queue can hold. When that number
is exceeded, the queue is automatically shut down and customers are asked to leave a message. The default
number of requests allowed in the queue is "200".
Can I have WebACD notify me when customers are assigned to me?
Yes. WebACD can play a sound, blink the window, or bring the window to the foreground to alert you to
new requests.

Managing CSRs
• As a support manager, can I monitor CSR support sessions?
• Can I ensure that requests are uniformly distributed among CSRs?

As a support manager, can I monitor CSR support sessions?
Yes. The WebACD Monitor allows you to monitor all queues and CSRs in real time.
Can I ensure that requests are uniformly distributed among CSRs?
WebACD can distribute requests in the following ways:
• Everybody mode: WebACD routes requests to any available CSR.
• Most Idle mode: WebACD identifies qualified CSRs and then assigns the request to the CSR who has
been idle the longest.
• Round Robin mode: WebACD identifies qualified CSRs and then distributes requests amongst those
CSRs in a round robin fashion.

General Questions
• Can I conduct simultaneous support sessions?
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• Can I make the WebACD console resemble my Website?
• Can WebACD help me ensure Service Level Agreement (SLA) compliance?
• Can I be notified if SLA is breached?
• Can I generate reports that show CSR performance and SLA compliance?
• Can I stop WebACD from automatically starting when I start my computer?
• When I am not at my computer, is it possible to automatically change my status to unavailable?
• What's the best way to gather diagnostic system information from customer computers?

Can I conduct simultaneous support sessions?
Yes.
Can I make the WebACD console resemble my Website?
Yes. You can add a logo and select colors for the customer console. For details, see the branding section of
your WebEx Site Administrator guide on the Support page of your Support Center service site.
Can WebACD help me ensure Service Level Agreement (SLA) compliance?
To ensure that customers are serviced quickly, WebACD provides:
• Request routing and distribution rules (Most Idle, Round Robin, etc.) to make sure that customer requests
are handled within a specified period of time.
• A threshold that you can set to automatically escalate unanswered requests to a manager.
Can I be notified if SLA is breached?
Yes. As you create queues, specify the email addresses of managers to notify when SLA is breached.
Can I generate reports that show CSR performance and SLA compliance?
Yes. When you generate reports, just enter "Wait time" as the search string. You can also run Call Volume
reports to analyze the wait time pattern for customer requests.
Can I stop WebACD from automatically starting when I start my computer?
Yes.
When I am not at my computer, is it possible to automatically change my status to unavailable?
Yes. You can set your WebACD Inbox preferences to specify the period of time after which you are considered
to be unavailable.
What's the best way to gather diagnostic system information from customer computers?
You can gather customer diagnostic information by selecting System Information on your CSR console. You
can save the information and upload it to your ticket management system.
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Getting Started
• What do I need to use WebEx System Management?
• What are my options for deploying System Management on remote computers?
• Do my users need to have administrator rights to install System Management?
• Does WebEx System Management work with firewalls?

What do I need to use WebEx System Management?
Remote assets will need at least 50 MB disk space to install the System Management agent. Site administrators
will also need:
• 350 MB disk space for the Enterprise Change Management (ECM) and online backup and anti-virus
components
• Domain administrator rights for Windows 2000 and XP systems
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Note

WebEx System Management currently does not support non-English operating systems.

What are my options for deploying System Management on remote computers?
Choose from the following deployment methods:
• URL link: Receive a link from WebEx by email or IM and use it to install the WebEx System Management
agent.
• Log in scripts: Download the installer and then run the script to perform the installation on remote
computers.
• Active directory group policy: Use the policy to distribute the installer to remote computers.
• Remote deployment kit: Use a network scan utility to discover the IP addresses of all computers in the
subnet and then use RDK to distribute WebEx System Management agents on remote computers. See
the System Management Getting Started guide on the Support page of your Support Center service site
for more information.
Do my users need to have administrator rights to install System Management?
Yes, but if they do not have administrator privileges, you can use System Management's domain impersonation
feature to access locked systems so that you can install software on them.
Does WebEx System Management work with firewalls?
Yes. As long as assets can connect to the Internet and outbound communication ports 80 and 443 are enabled,
you can use WebEx System Management to manage them.

Managing Assets
• How does WebEx System Management help me manage remote computers?
• Can I run asset reports?
• Can I associate individual assets with employees?

How does WebEx System Management help me manage remote computers?
The System Management Asset Management module helps you manage and control hardware and software
installations by:
• Providing asset information
• Facilitating major upgrades and rollout planning
• Automating the PC inventory process
• Allowing you see to actual software usage on individual assets
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Can I run asset reports?
Yes. Use System Management's Integration Web Service (IWS) to download asset data into Microsoft Access
or SQL Server databases. You can also have our Professional Services Organization to customize reports for
you.
Can I associate individual assets with employees?
Yes. Use WebEx System Management to import user contact data and then associate users with specific assets
so that you can:
• Initiate move/add/change (MAC) actions from the System Management console
• Provide asset information for user support sessions
• View asset data that is specific to equipment, offices, and locations

Distributing Software
• How does System Management help me distribute software?
• Can I distribute software to remote employees?
• What is the best way to deploy large packages?

How does System Management help me distribute software?
Use System Management to determine if assets need software and patch updates, then perform the upgrade
to any or all assets. If an asset is not connected to the internet the update is performed as soon as the asset
connects to the Internet.
Can I distribute software to remote employees?
Yes. As long as an employee connects to the Internet, that employee will receive software distribution packages.
If an employee is traveling or on vacation when you distribute software, they will receive the distribution the
next time they connect to the Internet.
What is the best way to deploy large packages?
You can:
• Manage bandwidth consumption by setting bandwidth policies and download rules.
• Specify a maximum number of concurrent downloads.
• Schedule distributions to occur during periods of low activity.
• Set up a relay server in your environment and download packages once from WebEx data center to the
relay servers. Then distribute the package from the relay servers to remote assets.
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Distributing Patches
• How does WebEx Patch Management help me deploy patches?
• How will I know when a new patch is available for deployment?
• Are all computers compatible with Patch Management?
• Can I use more than one SUS server?
• Can I prevent certain assets from receiving patches?
• Do I need to reboot remote computers after each patch is installed?
• Can I distribute software that requires pre- and post-installation scripts?
• If the connection is lost during a distribution, do I have to start the download again from beginning?
• Can I distribute software packages to employees do not have administrator rights on their computers?

How does WebEx Patch Management help me deploy patches?
When Microsoft releases a critical patch; WebEx tests the patch and uploads it to your site. To ensure 100%
compliance, you can generate patch compliance reports to determine which assets need updates, and then
distribute patches from the WebEx site to the assets that need them.
WebEx System Management runs daily and downloads patches according to the update policies you set.
System Management downloads only those patches that are approved by your Microsoft Software Update
Services (SUS) administrator.
How will I know when a new patch is available for deployment?
When a new patch is available, you will receive an email message from WebEx that announces the availability
of the patch.
Are all computers compatible with Patch Management?
The WebEx System Management agent works on all Windows systems, but the Patch Control features (patch
scanning and automatic updates) are only available for Windows 2000, XP, and 2003.
Can I use more than one SUS server?
Yes. You can use several SUS servers with WebEx System Management.
Can I prevent certain assets from receiving patches?
Yes
Do I need to reboot remote computers after each patch is installed?
No. You can install multiple patches and then reboot the remote computer after the last patch is installed.
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Can I distribute software that requires pre- and post-installation scripts?
Yes. WebEx can create a special package for you; contact WebEx Profession Services for details.
If the connection is lost during a distribution, do I have to start the download again from beginning?
No. When the connection is restored, the process resumes from where it failed.
Can I distribute software packages to employees do not have administrator rights on their computers?
Yes. You can distribute software using the system context

Backing Up Assets
• How does WebEx Back Up Management help me back up remote computers?
• What do I need to use Back Up Management?
• Are the backups secure?
• How long does the backup process take?
• How often can I perform backups?
• When assets are moved, added, and changed, does the backup data remain with the equipment or the
user?
• What is the file retention policy?
• Can I access backed up files over the Internet?

How does WebEx Back Up Management help me back up remote computers?
WebEx Backup Management performs an automated, secure, off-site backup of your enterprise's computers.
Backup Management works fast even over the slowest network connection to ensure that your data is constantly
protected. With 128-bit AES encrypted transmissions, your data is kept secure.
You can choose to backup only critical data files, not the commercial software that you install from disk or
CD. This way if a user's system crashes, the data is safe and the user can re-install the software so that essential
information is written into the Windows registry. You can also choose to exclude certain types of files, such
as MP3 files, to save space and time during backups.
The Backup Management agent is available as a software distribution package from your WebEx System
Management console. You can use the WebEx Software Distribution console to push the Backup Management
agent to remote computers.
System Management automatically backs up desktop data daily between 12:30 and 1:00 p.m. (local time).
Your users can schedule backups at any time or have them run automatically as part of a shut down routine.
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What do I need to use Back Up Management?
Deploy the WebEx System Management agent on the remote computers and configure your firewalls to allow
outbound access on TCP port 16384.
Are the backups secure?
Yes. The data is compressed and encrypted using the AES 128-bit encryption and then stored in a secure
off-site facility.
How long does the backup process take?
The time varies depending on your Internet connection speed and the level of service that you signed up for.
Typically, a 100 MB backup takes about 10 to 15 minutes. Each successive backup takes less than six minutes
because only incremental changes are compressed, encrypted, and backed up.
How often can I perform backups?
You can back up data as often as you'd like; as long as your computer is turned on and connected to the
Internet. You can use the WebEx Data ProtectorTM Backup Wizard to set the date and time of your backups.
When assets are moved, added, and changed, does the backup data remain with the equipment or the user?
The data is kept with the user. When a user leaves the company, the data is not kept on the computer, even if
a new user will be taking over the former employee's responsibilities.
What is the file retention policy?
The default retention policy stipulates that:
• The 10 most recent versions of each file are retained for 90 days
• Deleted files are retained for 90 days
• Files that are removed from backup are still retained for seven days
• Files associated with cancelled accounts are deleted after 30 days
Can I access backed up files over the Internet?
Yes. To retrieve files, all you need to know your private encryption key and account number. To get the private
key, from the Security menu, select Options, and then select View Encryption Key.

Using Virus Protection
• How does WebEx Virus Protection help me protect assets?
• How can I deploy Virus Protection in my organization?
• Can I use Virus Protection to immediately fix infected computers?
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How does WebEx Virus Protection help me protect assets?
WebEx Virus Protection provides:
• Anti-virus definition status reports
• Infected computer reports
• Individual asset virus scan logs
• Centralized distribution of anti-virus updates

Note

If you currently use Symantec AntiVirus, you do not need to renew your Symantec license; just use the
Symantec software that comes with WebEx Virus Protection.

How can I deploy Virus Protection in my organization?
You can use WebEx System Management to deploy virus protection packages and then scan:
• Just once
• Daily at 12 noon
• Daily at 10 p.m.
• Every Wednesday at 12 noon
• Every Wednesday at 10 p.m.
Can I use Virus Protection to immediately fix infected computers?
You can push the anti-virus jumpstart package to all infected computers to ensure that each computer has
latest data files.

Security
• How secure is the WebEx System Management agent?
• Do System Management reports comply with the BSA (Business Software Alliance) compliance
requirements?

How secure is the WebEx System Management agent?
The WebEx System Management agent sends communications every fifteen minutes from the asset to
fully-redundant data centers that house a library of software services to enable round-the-clock device
management. These outbound communications use SSL encryption on ports 80 and 443 to report information
about the asset such as the hardware and software inventory, patch status, virus information, and backup status.
Because agent communication is always outbound and initiated from the client, it provides top-level security
and allows you to prevent access from systems outside your corporate network. System Management works
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in all environments; you do not have to create holes in the firewall that might expose vulnerabilities. See the
WebEx System Management security white paper for details.
Do System Management reports comply with the BSA (Business Software Alliance) compliance requirements?
Yes. WebEx System Management reports display all the information you need to answer questions related to
a software compliance audit, such as what software is installed on each computer.
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General Questions
• What are WebEx Productivity Tools?
• What desktop integrations are available using Productivity Tools?

What are WebEx Productivity Tools?
WebEx Productivity Tools make it very easy for users to start, schedule, invite, and join WebEx meetings
from their desktop or from commonly used desktop applications.
What desktop integrations are available using Productivity Tools?
The following Productivity Tools are available for use with WebEx services:
• Microsoft Outlook integration
• IBM Lotus Notes integration
• Instant messenger integrations:
◦Microsoft Lync/ Microsoft Office Communicator (OCS)
◦Lotus Sametime
◦Yahoo
◦Google Talk
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◦Skype
◦AOL AIM
• Microsoft Office integrations for Word, Excel and PowerPoint
• Microsoft Internet Explorer integration
• Mozilla Firefox integration

Installation and Configuration
• How can I install Productivity Tools?
• My WebEx service site has automatic installation of Productivity Tools turned off. How can I install
Productivity Tools manually?
• My WebEx service site has automatic installation of Productivity Tools turned on, but I don't want to
use Productivity Tools. Can I turn off the automatic installation?
• I like some of the Productivity Tools, but I don't want to use all of them. How can I configure Productivity
Tools to be available only for my desired desktop applications?
• How can I uninstall Productivity Tools?
• Can I use WebEx Productivity Tools with multiple WebEx service sites?
• I am a Linux desktop or MAC user. Are Productivity Tools available for me?
• Can I implement single sign-on (SSO) through integration with an identity management system, such
as CA Siteminder, Sun Java Access Manager, or Oracle Oblix, so my employees can use their LAN
credentials to log on to WebEx and not have to maintain separate user IDs and passwords?
• Can I implement single sign-on (SSO) for CMR Hybrid (WebEx-enabled TelePresence) users?

How can I install Productivity Tools?
All that is required is logging on to your WebEx service site. When you log on to your WebEx service site,
Productivity Tools are automatically installed on your desktop. If automatic installation is turned off on your
WebEx service site, you can download them yourself. In the left navigation bar of your WebEx site, under
Support, select Downloads. In the Downloads page, under Productivity Tools heading, make sure the correct
operating system is selected, and then select Download.
If you are a CMR Hybrid (WebEx-enabled TelePresence) user, you will be required to restart Microsoft
Outlook after installing WebEx Productivity Tools.
My WebEx service site has automatic installation of Productivity Tools turned off. How can I install Productivity
Tools manually?
There are multiple options to install productivity tools manually:
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• Select My WebEx > Productivity Tools Setup (on the left navigation bar). The Productivity Tools
Setup page appears. Under On Your Desktop, select Download Productivity Tools.
• In the left navigation bar of your WebEx Service site, under Support, select Downloads. In the
Downloads page, next to the WebEx Productivity Tools heading, select Download Now.
• Go to the Schedule a Meeting page. At the top of the page, there is a contextual awareness tip about
Productivity Tools. Select on the Install Productivity Tools link to install Productivity Tools.
My WebEx service site has automatic installation of Productivity Tools turned on, but I don't want to use
Productivity Tools. Can I turn off the automatic installation?
Yes. Select My WebEx > My Profile. In the Productivity Tools section, turn off the Automatically download
Productivity Tools when logging in to WebEx service site option.
I like some of the Productivity Tools, but I don't want to use all of them. How can I configure Productivity
Tools to be available only for my desired desktop applications?
On your desktop, select Start > Programs > WebEx > Productivity Tools > WebEx Settings. In the WebEx
Settings dialog box, select the Tools tab. In the list of available Productivity Tools, turn off the options for
the applications you do not want to use Productivity Tools with.
How can I uninstall Productivity Tools?
On your desktop, select Start > Programs > WebEx > Productivity Tools > Uninstall. You can also
uninstall using Add or Remove Programs from the Windows Control Panel.
Can I use WebEx Productivity Tools with multiple WebEx service sites?
You can not use Productivity Tools with multiple WebEx service sites simultaneously. If you need to switch
service sites, select Start > Programs > WebEx > Productivity Tools > WebEx Settings and update your
site and account information to use Productivity Tools with the new site.
I am a Linux desktop or MAC user. Are Productivity Tools available for me?
Currently Productivity Tools are available only for Microsoft Windows users and Mac users.
Can I implement single sign-on (SSO) through integration with an identity management system, such as CA
Siteminder, Sun Java Access Manager, or Oracle Oblix, so my employees can use their LAN credentials to
log on to WebEx and not have to maintain separate user IDs and passwords?
Yes. Refer to the Site Administration document for Productivity Tools on how to configure your WebEx site
to implement single sign-on (SSO) and integrate with an identity management solution.
Can I implement single sign-on (SSO) for CMR Hybrid (WebEx-enabled TelePresence) users?
Yes. Refer to "Configuring Single Sign On in Cisco TMS" in the "Configuring Cisco TelePresence Management
Suite" chapter of the Cisco Collaboration Meeting Rooms (CMR) Hybrid Configuration Guide on the Cisco
TelePresence Management Suite (TMS) Configuration Guides page.
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Scheduling Meetings using Productivity Tools
• What are the different ways I can schedule meetings using Productivity Tools?
• How do I schedule a WebEx meeting using Outlook or Lotus Notes integration?
• How do I start a scheduled WebEx meeting using Outlook or Lotus Notes integration?
• How do my attendees join my scheduled WebEx meeting using Outlook or Lotus Notes integration?
• I know my preferences (such as teleconference, join before start, tracking code, etc.) for WebEx meetings
that I schedule using Outlook or Lotus Notes integration. Why do I need to specify these options for
every meeting? Can I specify these preferences once so they are available for all future meetings?
• Are exceptions to a recurring meeting series supported for CMR Hybrid (WebEx-enabled TelePresence)
Meetings?

What are the different ways I can schedule meetings using Productivity Tools?
If you use Microsoft Outlook or IBM Lotus Notes as your email client, you can schedule WebEx meetings
directly from the Outlook or Lotus Notes scheduler using Productivity Tools.
How do I schedule a WebEx meeting using Outlook or Lotus Notes integration?
You schedule a WebEx meeting with Outlook or Lotus Notes integration the same way you schedule other
meetings. In the scheduler, select Add WebEx Meeting to add a WebEx meeting to your Outlook or Lotus
Notes meeting.
How do I start a scheduled WebEx meeting using Outlook or Lotus Notes integration?
When you add a WebEx meeting to your Outlook or Lotus Notes meeting, the meeting on your calendar
includes a URL link that you can click to start a meeting.
How do my attendees join my scheduled WebEx meeting using Outlook or Lotus Notes integration?
When attendees open a meeting on their Outlook or Lotus Notes calendar, they will see a URL link that they
can click on to join the WebEx meeting. Attendees can also click on the URL link in the Outlook or Lotus
Notes meeting invitation to join the meeting.
I know my preferences (such as teleconference, join before start, tracking code, etc.) for WebEx meetings
that I schedule using Outlook or Lotus Notes integration. Why do I need to specify these options for every
meeting? Can I specify these preferences once so they are available for all future meetings?
When you schedule meetings on your WebEx site, you can save meeting templates to use for future meetings.
You can then use these meeting templates when you schedule meetings in Productivity Tools. In addition, if
your administrator has created predefined meeting templates for your organization, you can use those meeting
templates in Productivity Tools.
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Are exceptions to a recurring meeting series supported for CMR Hybrid (WebEx-enabled TelePresence)
Meetings?
No, exceptions to a recurring meeting series are not supported for CMR Hybrid (WebEx-enabled TelePresence)
meetings and Productivity Tools.
The following issues exist for exceptions to a recurring meeting series using CMR Hybrid meetings and
Productivity Tools:
• Exceptions to a recurring meeting series for CMR Hybrid meetings are still NOT supported as of
WBS29.13, and users are warned accordingly (for example, unsupported editing options are disabled,
and error messages are included in email invitations) when they attempt to schedule them using
Productivity Tools.
• WebEx meeting applications and TelePresence devices can join the same CMR Hybrid meeting, even
if a normal exception to a meeting series has been created. WebEx does not support creating orphan
meeting exceptions, such as adding WebEx to a single occurrence of a meeting series.
• Hosts can still edit the following items for a CMR meeting series that does not have exceptions: WebEx
special properties, such as alternate hosts, audio options, and the WebEx meeting password; Microsoft
Outlook common properties, such as subject and attendees; and TelePresence properties.
• Once an exception has been made to a CMR Hybrid recurring meeting series, the following conditions
exist:
• The Outlook common properties can still be edited for both the exception and the meeting series
• The TelePresence properties cannot be edited for either the exception or the meeting series (the
panel for editing TelePresence settings is disabled).
• The WebEx special properties cannot be edited for either the exception or the meeting series.
• If a WebEx-only meeting series has exceptions, TelePresence cannot be added to it.
• Unlike prior releases, in WBS 29.11.3 and later, the following features are not available for CMR Hybrid
users:
◦CMR Hybrid users do not have the ability to edit the TelePresence properties or WebEx special
properties in a CMR Hybrid series that has exceptions.
◦CMR Hybrid users do not have the ability to add or remove TelePresence or WebEx entirely from
a series if it has exceptions
• The Mac version of Productivity Tools, which is new in WBS29.13, is expected to have similar limitations
for exceptions to a meeting series.

Instant Meetings using Productivity Tools
• What are the different options I have to start instant meetings?
• What is the WebEx Productivity Tools panel?
• How can I invite an attendee to a WebEx meeting using the WebEx Productivity Tools panel and Meet
Now?
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• Can I join a WebEx meeting using the WebEx Productivity Tools panel?
• Can I start my scheduled WebEx meetings using the WebEx Productivity Tools panel?
• How can I invite my buddy to a WebEx meeting using a instant messenger integration?
• I already have a WebEx meeting in progress on my desktop-how can I invite my instant messenger
buddy to an in-progress meeting?
• What is the best way to start a WebEx meeting from Microsoft Office documents?
• Are instant meetings supported for CMR Hybrid (WebEx-enabled TelePresence) meetings?

What are the different options I have to start instant meetings?
You can start instant meetings with the following Productivity Tools:
• One-Click
• Instant messenger integrations:
◦Yahoo
◦Google Talk
◦Skype
◦AOL AIM
◦Microsoft Office Communicator (OCS)
◦Lotus Sametime
• Microsoft Office integrations:
◦Word
◦Excel
◦PowerPoint
• Internet Explorer integration
• Mozilla Firefox integration
What is the WebEx Productivity Tools panel?
The WebEx Productivity Tools panel (formerly called the WebEx One-Click panel) is a simple way to start
and join meetings and to send meeting invitations without logging in to your WebEx site or navigating Web
pages. The WebEx Productivity Tools panel is available from the Start menu, from the WebEx Productivity
Tools shortcut on your desktop, and from the WebEx Productivity Tools icon in the taskbar.
How can I invite an attendee to a WebEx meeting using the WebEx Productivity Tools panel and Meet Now?
Right-click the WebEx Productivity Tools icon in the taskbar and select Open WebEx Productivity Tools.
In the WebEx Productivity Tools panel, you can either type your contact’s email address or select the Address
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book icon to select your contacts from your Outlook or Lotus Notes directory. Once you have selected your
contacts, you can select Meet Now to start a WebEx meeting and automatically send invitations, using your
local mail application, to all selected contacts to join the WebEx meeting.
Can I join a WebEx meeting using the WebEx Productivity Tools panel?
Yes. Right-click the WebEx Productivity Tools icon in your taskbar and select Join Meeting. Type the host’s
email address or the meeting number to join WebEx meeting. You need to know the meeting password to
join your host’s meeting.
Can I start my scheduled WebEx meetings using the WebEx Productivity Tools panel?
Yes. Right-click the WebEx Productivity Tools icon in your taskbar and select Start Scheduled Meeting.
How can I invite my buddy to a WebEx meeting using a instant messenger integration?
Start a instant messenger chat session with your buddy. In the chat window, select Start a WebEx Meeting
to start a WebEx meeting and then send a meeting invitation to your buddy as a chat message.
I already have a WebEx meeting in progress on my desktop-how can I invite my instant messenger buddy to
an in-progress meeting?
Start a chat session with your buddy. In the chat window, select Invite to Meeting to invite your buddy to an
in-progress WebEx meeting.
What is the best way to start a WebEx meeting from Microsoft Office documents?
In the toolbar of your Microsoft Office document, spreadsheet, or presentation, select Share as Application.
This starts a WebEx meeting and automatically shares that application. To invite others to the meeting select
the Participants Panel button in the floating icon tray, select Invite or Remind Participants, and then select
Invite by Email or Invite by IM. You can also invite attendees using One-Click or an Instant Messenger
integration.
Are instant meetings supported for CMR Hybrid (WebEx-enabled TelePresence) meetings?
No. You cannot start an instant CMR Hybrid (WebEx-enabled TelePresence) meeting; you can only schedule
CMR Hybrid meetings. When CMR Hybrid users start instant meetings, they are WebEx-only meetings and
do not include TelePresence integration.
Starting with WBS29.11, instant meetings that you start with the Meet Now command (formerly called
One-Click Meeting) are held in your Personal Room by default. You can change this option in “Preferences.”
CMR Hybrid (WebEx-enabled TelePresence) users will have Personal Rooms, but only users who join from
a WebEx meeting application or app can join those Personal Rooms. TelePresence devices cannot join Personal
Room meetings on CMR Hybrid sites. Sites and user host accounts must have CMR Cloud in order for users
to join Personal Room meetings from TelePresence devices or other video conferencing systems or applications.
A workaround for an instant meeting that uses both WebEx and TelePresence is to start a meeting from a
TelePresence system and then the named host has selects Instant WebEx Meeting on the meeting detail page
to generate a URL that allows external participants to join the TelePresence meeting from a WebEx application
or mobile app.
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Site Administration
• I don’t want hosts to automatically install Productivity Tools. What are the different options I have for
installing Productivity Tools on users' desktops in my company?
• Users in my company do not have administrator privileges. How can they install Productivity Tools?
• All computers in my company are locked down. How can I install Productivity tools on all users' desktops
in my company?
• Meetings run by our executives are confidential and sensitive meetings. Employees in my company
know the email addresses for executives. How can I prevent employees from joining confidential and
sensitive meetings?
• I don't want my employees to use instant messenger integrations. Can I pick and choose which
Productivity Tools my employees will use?
• I don't like the default contextual awareness tips that appear on Schedule a Meeting pages. Can I customize
those messages?
• What are the best practices for deploying Lotus Notes integration across all computers in my company?

I don’t want hosts to automatically install Productivity Tools. What are the different options I have for installing
Productivity Tools on users' desktops in my company?
You can turn off automatic installation of Productivity Tools with Site Administration options. You can use
the following methods to install Productivity tools on all users' desktops:
• Install WebEx Productivity Tools on user's desktops using a software distribution tool, such as Microsoft
SMS, IBM Tivoli, WebEx System Management, and so on.
• Request hosts to manually download WebEx Productivity tools from the Download section of WebEx
Support pages.
• Follow the instructions for silent installation or mass deployment of WebEx Productivity Tools in the
IT Administrator Guide for Mass Deployment of WebEx Productivity Tools.
Users in my company do not have administrator privileges. How can they install Productivity Tools?
Administrator privileges are not required to install WebEx Productivity Tools. Even standard users with no
administrator privileges can install Productivity Tools.
All computers in my company are locked down. How can I install Productivity tools on all users' desktops
in my company?
Turn off automatic installation and automatic upgrades for Productivity Tools in the WebEx service site
administration options. Use a software distribution tool, such as Microsoft SMS, IBM Tivoli, WebEx System
Management, and so on, to install Productivity Tools on the all users' desktops in your company.
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Meetings run by our executives are confidential and sensitive meetings. Employees in my company know
the email addresses for executives. How can I prevent employees from joining confidential and sensitive
meetings?
Schedule confidential and sensitive meetings as unlisted meetings, and then in the Productivity Tools section
of Site Administration, turn off the Allow users to join unlisted meetings using the host's email address
option.
I don't want my employees to use instant messenger integrations. Can I pick and choose which Productivity
Tools my employees will use?
Yes. Go to Productivity Tools section of Site Administration. In the list of Productivity Tools, turn on or off
Productivity Tool options based on your business needs.
I don't like the default contextual awareness tips that appear on Schedule a Meeting pages. Can I customize
those messages?
Yes. You can customize messages in the Productivity Tools section of Site Administration.
What are the best practices for deploying Lotus Notes integration across all computers in my company?
Other WebEx documents are available that contain information about Lotus Notes deployment. Ask your
Client Services Manager to provide the Lotus Notes deployment checklist document, and then follow the
instructions for mass deployment of WebEx Productivity Tools in the IT Administrator Guide for Mass
Deployment of WebEx Productivity Tools.
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General Questions
• What's the capacity for WebEx Audio?
• Are there any calling restrictions from certain locations?
• Does WebEx Audio support a mixed-mode or hybrid audio conference with VoIP attendees?
• What are the known issues and limitations for CMR Hybrid (WebEx-enabled TelePresence) and CMR
Cloud meetings that use telephony service provider (TSP) audio?

What's the capacity for WebEx Audio?
WebEx Audio capacity is 1000 attendees for all supported WebEx services with 500 attendees on telephony
and 500 on WebEx integrated VoIP.
Are there any calling restrictions from certain locations?
Yes, this document outlines those restrictions: http://www.webex.com/pdf/tollfree_restrictions.pdf
Does WebEx Audio support a mixed-mode or hybrid audio conference with VoIP attendees?
Yes, WebEx Audio supports a hybrid audio in the Meeting Center and Training Center services.
What are the known issues and limitations for CMR Hybrid (WebEx-enabled TelePresence) and CMR Cloud
meetings that use telephony service provider (TSP) audio?
For some telephony service provider (TSP) audio accounts, if a host with a TSP account schedules two adjacent
CMR Hybrid or CMR Cloud meetings, with the second one scheduled to start immediately after the first one
ends, and if the TelePresence scheduling system automatically extends the first meeting past the scheduled
end, the second meeting will end automatically because the same TSP audio account and host access code
cannot be used for both meetings at the same time.
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To work around this problem, hosts can set up two different TSP audio accounts with different host access
codes, and use one account for the first meeting and the other account for the second meeting. Another option
is for the administrator to turn off the option for the TelePresence systems to automatically extend the meeting.
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General Questions
• What are the features of Integrated VoIP audio?
• What is the attendee capacity for Integrated VoIP audio?
• How does WebEx VoIP audio help me know if attendees cannot hear me?

What are the features of Integrated VoIP audio?
The following are brief descriptions of the features of Integrated VoIP audio:
• Services Support: Integrated VoIP is supported in the services and platforms listed in the following
table:
Center

Windows

Solaris

Linux

Macintosh

Meeting Center

Yes

Yes

Yes

Yes

Training Center

Yes

Yes

Yes

Yes

Event Center

Yes

Yes

Yes

No

Support Center

Yes

Yes

Yes

Yes

• Hardware requirements: No special hardware is required to use integrated VoIP. A full duplex sound
card and speakers or headset are all that is required. A headset is recommended for users wishing to
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speak. USB devices are also supported on Windows and Mac as long as the device has drivers for the
operating system.
• Number of attendees: Integrated VoIP supports up to 500 attendees (1,000 for Training Center).
• TCP/UDP support: Integrated VoIP can use UDP or TCP as a transport method. UDP transport allows
offers lower latency for VoIP sessions. TCP offers optional SSL security with slightly higher latency.
When VoIP is started as a service, each client attempts to connect via UDP first and then reverts to TCP
as a transport protocol. Meetings can support a mix of UDP and TCP attendees.
• SSL Support: Integrated VoIP can (if the site is SSL enabled) use SSL as a transport method. SSL
provides highly secure transport for VoIP traffic. SSL may introduce additional latency for VoIP
connections.
• Echo Cancellation: Integrated VoIP features built in echo cancellation offering improved performance
under most conditions.
• Automatic Gain Control: Integrated VoIP features automatic gain control provides level equalization
for meeting attendees.
• Cross-platform support: Cross-platform support for Support Center
What is the attendee capacity for Integrated VoIP audio?
You can invite up to 500 attendees to a session (1,000 for Training Center).
How does WebEx VoIP audio help me know if attendees cannot hear me?
Integrated VoIP displays a network indicator in the Volume window (available from the Audio menu) that
shows how your network is performing and the overall quality of the audio your attendees hear. The indicator
displays one of the following colors:
• Green, when more than 85% of your attendees are experiencing good-quality audio
• Yellow, when fewer than 50 to 85% of your attendees are experiencing good-quality audio
• Red, when fewer than 50% of your attendees are experiencing good-quality audio

System Requirements and Technical Information
• What are the system requirements?
• Which WebEx service sites offer VoIP audio?
• What do I need to use WebEx Integrated VoIP?
• Can I use TCP, UDP, or PSTN with WebEx Integrated VoIP audio?
• Can I use WebEx Integrated VoIP if my site is SSL-enabled?
• Can I use VoIP over dial-up connections?
• Can I provision WebEx VoIP from an EMX node.
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• Is VoIP a full or half duplex transmission?

What are the system requirements?
Your system must meet the requirements shown in Cross-platform Features (WBS30).
Which WebEx service sites offer VoIP audio?
You can use Integrated VoIP with the WebEx services and computers listed in the following table:
Center

Windows

Solaris

Linux

Macintosh

Meeting Center

Yes

Yes

Yes

Yes

Training Center

Yes

Yes

Yes

Yes

Event Center

Yes

Yes

Yes

No

Support Center

Yes

Yes

Yes

Yes

What do I need to use WebEx Integrated VoIP?
To use WebEx Integrated VoIP, you will need a full duplex sound card and speakers or headset. To speak,
you should have a microphone that is connected to your computer. For best results, we recommend that you
use a headset.
Can I use TCP, UDP, or PSTN with WebEx Integrated VoIP audio?
You can use the UDP or TCP protocols with WebEx VoIP audio. With UDP, you may experience lower
latency rates (delays) than with TCP, but with TCP, you can use the SSL security protocol (and the latency
rate will probably be greater). When VoIP starts, WebEx tries to connect using UDP and then switches to
TCP. You can conduct sessions where some attendees use UDP while others use TCP.
UDP is only supported for non-SSL sites. In order to use UDP, the IP ports 9000 and 9001 must be opened
for outbound communication using UDP on the corporate firewall. UDP is selected automatically if the ports
are open.
Can I use WebEx Integrated VoIP if my site is SSL-enabled?
Yes. You can use SSL if you also use the TCP transport protocol.
Can I use VoIP over dial-up connections?
Integrated VoIP is not recommended for dial-up connections. UCF-based PowerPoint sharing should work
satisfactorily as long as video is not enabled and only one active microphone is in use. Application and desktop
sharing in concert with Integrated VoIP is not supported on connections of less than 56Kb/s.
Can I provision WebEx VoIP from an EMX node.
Integrated VoIP can be provisioned from a WebExTM Extended MediaTone eXchange (EMX) node on a
case-by-case basis. Please contact Product Management for further information.
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Is VoIP a full or half duplex transmission?
Integrated VoIP is full duplex, meaning multiple attendees can speak at the same time. This is similar to a
traditional teleconference using PSTN. Half duplex is a VoIP conference where only one attendee can speak
at a given time, similar to a CB radio.

Troubleshooting
• Why is there a delay in the audio during my VoIP conferences? Why does the quality seem to be not as
good as traditional telephony?
• Why do I get good quality on some VoIP calls, but not on others?
• What if the customer experiences any technical issues with Integrated VoIP?

Why is there a delay in the audio during my VoIP conferences? Why does the quality seem to be not as good
as traditional telephony?
Traditional PSTN-based teleconferencing is circuit-based, which gives each participant a dedicated channel
to the teleconference bridge; the delay is virtually unnoticeable. Typically, the only delay one encounters in
a circuit-switched voice environment is due to the distance the voice must travel). A good VoIP solution will
have delay of about 0.25 - 0.5 seconds, depending the following factors:
• Network congestion: VoIP solutions send the voice information over an IP network (such as the Internet),
which is a shared medium on which the packets are routed on a first-in/first-out basis. Congestion on
any of the routers between the meeting participants will delay and/or degrade the audio.
• Encoding process: When you speak into the microphone, the sound card in your PC captures and
digitizes the sound. This information is then broken up into data packets that are sent over the network
to the conference server(s). The conference server(s) sends these packets to the other attendees’ PCs,
where the encoding process is reversed. The encoding process for integrated VoIP relies on audio
components (microphone, speakers, and sound card), and these can vary greatly from PC to PC. Lower
quality components will produce lower quality audio.
Such delay and audio quality issues are common to the VoIP solutions offered by all the vendors—not just
WebEx. VoIP solutions offered by vendors such as Centra, et al., suffer from the same shortcomings when
compared to PSTN. Based on our testing, the delay and audio quality of WebEx VoIP is at least on par with
that of Centra's.
Why do I get good quality on some VoIP calls, but not on others?
It is hard to have a straight answer to this question due to the number of possibilities. You can have a perfect
VoIP conference with a 28-Kbps connection to a country halfway around the world, followed by a scratchy
mess for a call to the next state with a 56-Kbps or a 300+-Kbps connection. The quality is almost entirely
determined by the sample rate (number of "slices" per second it uses to reproduce your voice) of the VoIP
software, plus the throughput of your internet connection. A 56-Kbps (or a 300+-Kbps LAN, for that matter)
connection does not ensure that you can move data across the Internet at that speed; the actual speed is
determined by traffic levels on all networks between the source and end point, and the equipment capabilities
at the source and end point. In general, poor-quality transmissions are a result of traffic and cannot be avoided
completely in VoIP that uses Internet for all or part of the voice-data traffic.
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What if the customer experiences any technical issues with Integrated VoIP?
Follow the standard Technical Support escalation process.
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General Questions
• What tools does WebEx provide for recording, editing, and playing recordings?
• What do I need to play recordings?
• Can I play WebEx recordings with any multimedia player?
• How can I get the WebEx recorder, editor, and players?
• How do I convert WebEx network-based recording files (ARF) to Windows Media File format (WMV)
, Flash format (SWF), or MPEG-4 format (MP4)?
• When I try to convert my ARF file to MP4 format, I'm asked for a URL, username, and password. What
should I enter?
• My WebEx site requires that I sign in through my company website (through single sign-on) and I don't
have a WebEx username and password. What should I do if I want to convert ARF files to MP4 format?
• How do I connect the DynaMetric adapter to my computer and phone?
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What tools does WebEx provide for recording, editing, and playing recordings?
With the WebEx recorders you can record everything that happens in a WebEx meeting; audio, video, chat
conversations, notes, etc.
There are two options for recording a WebEx meeting: Network-based recording (Record on Server) with the
Network-Based Recorder (NBR) and Local recording. When using Network-based recording, no additional
hardware is required. All meeting content is automatically recorded on the WebEx servers and is easily
accessible.
If you want to change the recording, such as making it shorter or eliminating sections where nothing important
is happening, we provide another tool that allows you to change it. If you save recordings to your WebEx
service site, you can publish the recording on a Web page so that others can play it or download it to their
computer.
Choose from the following players and recorders:
WebEx Network
Recording Player for
Advanced Recording
Format (.arf) files

Use it to play recordings in ARF format (Network-based recordings). Use the player
to convert recording to Windows Media Format (.wmv), Flash format (.swf), or
MPEG-4 format (MP4). No editing is supported in the player. Basic editing is
supported on the recording properties on your WebEx service Web site, such as
truncating the beginning or end of the recording, and removing panels such as video,
chat, etc.

WebEx Recorder and This is a standalone recorder and player that allows you to save recordings in the
Player for Recording WebEx proprietary WRF format on your computer. You can also use it to record
Format (.wrf) files
applications or your computer to create software demonstrations, training, and so
on. You can then upload recordings to your WebEx site and share them with others
by sending them the provided streaming/download URLs.
WebEx Recording
Editor

Use this tool to add, delete, or rearrange parts of a recording in WRF format.

For detailed information about using each of these players, see the user guides on the Support page of your
WebEx service site.
What do I need to play recordings?
To play WebEx recordings you should have a sound card; to play recordings on the Web you should have an
Internet connection.
To record teleconferences when using WebEx stand-alone recorder, you should also have:
• A computer headset (presenters only)
• A phone headset (preferred over regular phone handsets for presenters who speak during a teleconference)
• A phone recording adapter

Note

This is required to connect your phone to your computer. WebEx recommends the
DynaMetric TLP-120 or TMP-636 adapters; the TMP-636 adapter supports bidirectional
audio which is useful for recording audio that contains UCF rich media.
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• A universal amplifier (WebEx recommends the Plantronics MX10 universal amplifier and headset)
Can I play WebEx recordings with any multimedia player?
Yes, but you must first download the recording from the WebEx service Web site and convert it to Windows
Media File (.wmv) format, Flash (.swf) format, or MPEG-4 format (MP4). To convert a network-based
recording (.arf) to Windows Media File (.wmv) format, Flash (.swf) format, or MPEG-4 format (MP4), use
the WebEx Network Recording Player.

Note

The WebEx Network Recording Player does not support converting recordings to MP4 format on Mac
systems.
To convert a local recording (.wrf) to WMV format, use the WebEx Recording Editor.
How can I get the WebEx recorder, editor, and players?
If you have an account on your WebEx site:
1
2
3
4

On the navigation bar at the left, select Support.
Select Downloads.
Scroll down to the Recorders and Players section and select Recording and Playback.
Download the desired player.

How do I convert WebEx network-based recording files (ARF) to Windows Media File format (WMV) , Flash
format (SWF), or MPEG-4 format (MP4)?
Start the WebEx Network Recording Player and open your ARF file. Select File > Convert Format and
select the desired format. Select the desired configuration in the dialog that pops up and select Convert.

Note

The WebEx Network Recording Player does not support converting recordings to MP4 format on Mac
systems.

When I try to convert my ARF file to MP4 format, I'm asked for a URL, username, and password. What should
I enter?
The URL you should enter is your WebEx site; for example, company.webex.com. The username and password
should be your WebEx username and password.

Note

The WebEx Network Recording Player does not support converting recordings to MP4 format on Mac
systems

My WebEx site requires that I sign in through my company website (through single sign-on) and I don't have
a WebEx username and password. What should I do if I want to convert ARF files to MP4 format?
Converting ARF files to MP4 format is not currently supported for WebEx sites integrated with single sign-on.
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How do I connect the DynaMetric adapter to my computer and phone?
To connect the adapter to phone:
1 Unplug your phone handset or headset from the phone jack and connect the DynaMetric telephone cord
to the jack.
2 Plug the phone handset or headset into the DynaMetric adapter.
3 Plug the DynaMetric gray audio cable into your computer's microphone jack. (If you are using the
DynaMetric TMP-636, plug the black cable into the computer's headphone jack.)

Network-Based Recording or “Record on Server”
• What is network-based recording (NBR) or "Record on Server"?
• Which centers can use network-based recording?
• Which operating systems are supported for a host using network-based recording?
• Do I need any additional hardware to use network-based recording for my meetings?
• What is the typical size of a one-hour recording?
• How long until my recordings are available for viewing or distribution?
• Where can I find my recordings?
• How do I get the WebEx Network Recording Player?
• How do I publish my recording to my attendees?
• Does network-based recording capture all the content of the meeting?
• Does network-based recording capture third-party audio?
• Does network-based recording capture VoIP and Audio Broadcasting?
• Can I pause the recording when I am recording on the server?
• I cannot play my network-based recording file on the latest WebEx Network Recording Player after my
site was upgraded. What should I do?

What is network-based recording (NBR) or "Record on Server"?
Network-based recording (NBR) is a recording option available to WebEx customers on release WBS25 or
later. Network-based recording enables you to capture all meeting content, including WebEx integrated audio,
VoIP audio, or third-party audio conference for later playback and sharing. NBR recordings are saved to
WebEx high-availability storage servers, making it easy to access all meeting content.
Unlike the stand-alone WebEx Recorder for WRF format files, network-based recording is managed completely
within the WebEx client and does not require the use of additional hardware, such as a phone recording adapter
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to record the teleconference. Network-based recording also provides basic editing capabilities through your
WebEx service site, without requiring the use a video-editing application.
Which centers can use network-based recording?
WebEx Meeting Center, Event Center, Support Center, and Training Center.
Which operating systems are supported for a host using network-based recording?
A host using network-based recording can use the Windows, Mac, Linux, and Solaris operating systems.
Do I need any additional hardware to use network-based recording for my meetings?
No, you can simply get it enabled on your site. In the Meeting Manager you can record all your meeting
actions, including the teleconference.
What is the typical size of a one-hour recording?
The size will vary depending on the action during the meeting. Typically, a meeting that does not contain
video usage ranges from 15 to 40 MB. A meeting with video usage can range in the 250MB size.
How long until my recordings are available for viewing or distribution?
Usually, recordings are available between 30 minutes and up to 24 hours after the end of your meeting
Where can I find my recordings?
Your recordings are posted to the My Files section of My WebEx, in theMy Recordings tab.
How do I get the WebEx Network Recording Player?
You can download the WebEx Network Recording Player by going to Support > Downloads > Recording
and Playback.
How do I publish my recording to my attendees?
Once your recordings are posted to the My Files section in My WebEx, a streaming URL is generated that
can be sent via email, posted to your WebEx service Web site, or posted to any other Web site.
Does network-based recording capture all the content of the meeting?
It records the full attendee-view of the meeting, so it captures the following:
• All public chat
• All data including annotations, polls results that are shared, and notes (requires publishing)
• Presenter video (requires at least one attendee present in the meeting)
• WebEx Audio (VoIP and telephony) and third-party audio
It does not capture the following:
• All private chat to the host
• Poll results not shared by the host
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• Breakout sessions (Training Center), Media Viewer (Event Center), Closed Captioning (Meeting Center),
and Practice Rooms (Event Center) panels are not recorded or played back
• When recording multi-point video, only the presenter’s video is recorded and played back
Does network-based recording capture third-party audio?
Yes. By entering your third-party conference number in the start recording process, you can capture third-party
audio in your recording.
Does network-based recording capture VoIP and Audio Broadcasting?
Yes, first start the recording and then start your audio selection.
Can I pause the recording when I am recording on the server?
Yes. A Pause button is available in the Recorder panel when you are recording on the server.
I cannot play my network-based recording file on the latest WebEx Network Recording Player after my site
was upgraded. What should I do?
Starting in WBS28.9, a new audio engine was introduced in the WebEx Network Recording Player, and an
old audio codec was removed. Due to those changes, network-based recording files (.arf) that were created
on a release earlier than WBS27.12 (earlier than March 2010) and use VoIP-only audio can no longer be
played on the latest Network Recording Player (they can still be played on earlier versions of the WebEx
Network Recording Player). Network-based recordings that use VoIP-only audio and that were created after
WBS27.12 can be played on the latest release using the new player with no issues. Network-based recordings
that use hybrid audio (mix of VoIP and telephony or telephony only) are not impacted. If you still have access
to an older version of the Network Recording Player, you can convert your recording file (.arf) to standard
video format such as Windows Media File (.wmv) format, Flash (.swf) format, or MPEG-4 format (MP4).

Note

The WebEx Network Recording Player does not support converting recordings to MP4 format on Mac
systems.

Playing Recordings
• Are recordings streamed or downloaded to my computer?
• Can I play a recording if my computer is not connected to the Internet?
• I cannot play my local recording file on the latest WebEx Recorder and Player after my site was upgraded.
What should I do?
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Are recordings streamed or downloaded to my computer?
As the recording owner (meeting host), you can choose either to stream the recordings by selecting the
streaming link or to download the recording file to your computer by selecting the download link. If you do
not own the recording, you can ask the host to send you the recording streaming and download links.
Can I play a recording if my computer is not connected to the Internet?
Yes. You need to download and install the appropriate stand-alone player. Select Support > Download >
Recording and Playback.
To play back network-based recordings (.arf), install the WebEx Network Recording Player for Advanced
Recording Format Files. To play back local recordings (.wrf), install the WebEx Recorder and Player for
WRF Format files.
I cannot play my local recording file on the latest WebEx Recorder and Player after my site was upgraded.
What should I do?
Starting in WBS28.9, a new audio engine was introduced in the WebEx Player and WebEx Recording Editor.
An old audio codec was also removed from these applications. Due to those changes, local recording files
(.wrf) that were created on a release earlier than WBS27.12 (earlier than March 2010) can no longer be played
on the latest WebEx Player or WebEx Recording Editor (they can still be played on older versions of these
applications). Local recordings that were created after WBS27.12 can be played on the latest release using
the new player with no issues.
If you still have access to an older version of the WebEx Recording Editor, you can convert your local recording
file (.wrf) to a standard video format-Windows Media File (.wmv).

Creating and Publishing Recordings
• Can I record everything that happens in a WebEx meeting, event, or session?
• How do I record a WebEx meeting, event, or session?
• After I record a WebEx meeting, what happens to the recording?
• How do I make my recording available to others?
• Can I record an Internet phone (VoIP) conference?
• Can I record WebEx meetings that contain UCF multimedia?
• How can I improve the quality of the audio when using local recording?
• What audio compression and sampling rates does WebEx support? Which ones should I use?
• How large are recording files?

Can I record everything that happens in a WebEx meeting, event, or session?
Yes. You can record the audio, video, desktop sharing, annotations, chat, and so on.
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How do I record a WebEx meeting, event, or session?
Just start or join your WebEx meeting, event, or session, and then press the red Record button.
You can also go to the Meeting menu in Meeting Center, the Event menu in Event Center, or the Session
menu in Training Center, select Start Recording.
In Support Center, you can select the Recording button from the session control panel.

Note

If you are a participant, you can record if your presenter has enabled recording for you.

After I record a WebEx meeting, what happens to the recording?
If you used network-based recording (Record on Server) you can find your recordings in the My Files section
of the My WebEx page of your WebEx service site, in the My Recordings tab.
How do I make my recording available to others?
Recordings made using network-based recording (Record on Server) will be in your WebEx service Web site
under My WebEx > My Files > My Recordings tab. Each recording has a streaming/download link that you
can email to others right from the recording list.
Selecting the Send Email icon opens the Share My Recording dialog box and allows you to send an email
message to others so they can view the recording.
You can also publish the playback/download link for your recording on your web site for others to access.
For details, see the Streaming Recordings on Your Web Site guide on your Support page.
Can I record an Internet phone (VoIP) conference?
Yes.
Can I record WebEx meetings that contain UCF multimedia?
Yes. To record the audio from UCF files at the same time that you record audio from a WebEx meeting, use
an adapter such as the DynaMetric TMP-636 or Plantronics MX-10. This allows you to send the sound from
your telephone through your computer's sound card. To record video or Flash files, turn off hardware
acceleration (or video overlay) on your computer's video card. For details, see the Windows Media Player
online help.
How can I improve the quality of the audio when using local recording?
If audio quality is poor or if there is no audio, make sure that:
• You used the WebEx Audio Setup Wizard to test your volume.
• If you are recording audio from a source other than a microphone, start the recorder and select the correct
recording source.
• If you hear “clicks and clacks” during playback, you may be using an older version of the WebEx Player.
Re-install the player on your computer and try again.
What audio compression and sampling rates does WebEx support? Which ones should I use?
WebEx supports the following audio recording formats:
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• G.723 (8 kHz) This is the default setting; it is optimized for streaming over the Internet.
• PCM (8 kHz, 22 kHz, 44 kHz) This results in higher audio quality but much larger file sizes. This is
recommended only for recordings that you distribute on a CD-ROM.
How large are recording files?
A one-hour recording is typically between 15 and 40 MB. The size varies depending on whether you have
included chat sessions, notes, video, and other features in your recording.

Editing Recordings
• Can I edit recordings?
• Can I dub the recording audio?
• Can I insert markers into a recording?

Can I edit recordings?
Yes. For recordings that were created using the WebEx WRF Player or the WebEx Recorder, Player, and
Recording Editor, you can use the WebEx Recording Editor to add, delete, or rearrange recorded data. You
can also specify segments in the recording, much like tracks on a CD, so that you can quickly navigate to a
specific point during playback. You can download the WebEx Recording Editor from your Support page.
For recordings that were made using network-based recording (Record on Server), basic editing can be done
on the Recording Properties page under Playback control, such as specifying a different start and end time
for the playback, and omitting specific panels (Participants, Chat, etc.) from the playback.
If additional editing is required, you can use the WebEx Network Recording Player to convert the recording
to a Windows Media File (.wmv) format, Flash (.swf) format, or MPEG-4 format (MP4), and then use
third-party editing tools to edit the file.

Note

The WebEx Network Recording Player does not support converting recordings to MP4 format on Mac
systems.

Can I dub the recording audio?
Yes, but this feature is only available for local recording (.wrf). "Dubbing" is where you copy all or part of a
recording. To dub a recording:
1
2
3
4
5

Use the WebEx Recording Editor to open the WebEx recording.
Use the Current Location Indicator to specify where you want to start dubbing.
From the Tools menu choose Dub Audio.
If you would like audio dubbing to end automatically at the certain point, specify the end point.
Select OK.
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Can I insert markers into a recording?
Yes, but this feature is supported only in the stand-alone WebEx Recording Editor. You can use markers to
specify certain points in the recording. During recording, press the Ctrl-Alt-M keys on your keyboard to insert
markers.

Recording CMR Hybrid Meetings
• Can I record a CMR Hybrid (WebEx-enabled TelePresence) meeting?

Can I record a CMR Hybrid (WebEx-enabled TelePresence) meeting?
Yes, starting with WBS29, you can record video, audio, sharing, chat, and polling for CMR Hybrid
(WebEx-enabled TelePresence) meetings. Just press Record as you normally would in your WebEx meeting
and your recordings will appear in your My Files > My Recorded Meetings list in the My WebEx section.
• File format: CMR Hybrid meeting recordings will be in MP4 format. Video will be recorded at 360 p.
• Viewing recordings: You can view your recordings from your My Recorded Meetings list by selecting
the Play button. Our streaming player will allow you to see screen sharing, application sharing, the
active speaker video camera feeds, the participant list, chat, and polling.
• Downloading recordings: You can download the screen sharing, application sharing, and audio portion
of your meeting as one MP4 file, which can be played back in most standard video players. The
downloaded recording does not contain active speaker video camera feeds, the participant list, chat, and
polling.
• Editing recordings: To edit a recording, you can download the MP4 file and use your own MP4 video
editor.
• Audio map: A new feature of our streaming player shows the time each person is talking (up to six
people). You can use the audio map to navigate to key places in the meeting where each participant is
talking.
If you are a participant, you can record the meeting if the host has enabled recording for you.

Known Issues and Workarounds
• What are the known issues?
• Why does a security message appear when I play a recording?
• Is the WOT format still supported?
• I see a black screen when I try to record an application. What can I do?
• I converted my network-based recording file (ARF) to Flash format (SWF) but I can't play it on my
Flash Player. What can I do?
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What are the known issues?
These are the known issues:
• New recordings created using a version 2.1 or later recorder will not play in pre-2.1 players, so be sure
to upgrade to and download the latest player.
• You cannot use the recording editor to combine pre-2.1 WRF files with 2.1 WRF files.
• The Solaris player does not play audio from WebEx Internet phone conferences.
• If a host starts a meeting, shares his webcam video, and starts recording the meeting with no other
participants, the video playback in the recording may have long periods of time where the video is frozen.
• A recording converted from ARF to MP4 or WMV format may have out-of-sync audio and video, and
it may have choppy audio quality.
Why does a security message appear when I play a recording?
A security message appears when you try to play a recording from the Web. The Windows operating system
displays this message to let you know that a plug-in for your Web browser is about to be installed.
When you see the message, just select Yes in Internet Explorer to allow the WebEx Player installation to
continue. The plug-in does not pose a security threat to your computer or network.
Is the WOT format still supported?
WOT is the original format for WebEx recordings. You can continue to use the WebEx WOT Player to play
recordings in this format, however the latest WebEx Player can play only recordings in the WebEx Recording
Format (WRF).
I see a black screen when I try to record an application. What can I do?
You are most likely recording an application that uses video overlay, such as an applications that play video
files. To record these applications, turn off hardware acceleration (or video overlay) on your computer's video
card. To turn off hardware acceleration, see the Windows Media Player online help.
I converted my network-based recording file (ARF) to Flash format (SWF) but I can't play it on my Flash Player.
What can I do?
If you are using Adobe Flash Player version 11.4 or later, you must update your WebEx Network Recording
Player to version WBS28.9 or later. After you update your WebEx Network Recording Player, you can convert
your ARF file to SWF format by selecting the High key frame rate conversion option.
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General Questions
• What is GSB? What is the name of my WebEx backup site?
• Is a WebEx backup site a separate site from the primary site?
• Am I automatically redirected to my backup site when necessary?
• What are some typical instances in which my meeting will be routed to my backup site?
• What happens if the primary site fails during the meeting?
• Can I access the meetings I scheduled on my primary site on my backup site?
• Can I create a new user account on my backup site and use the account on my primary site?
• Can I schedule a meeting on my backup site and start the meeting on my primary site?
• When will maintenance be performed?
• How do I know if I am on my backup site?
• How often is my primary site backed up? During what hours is the site backed up?
• Can I use my backup site even if my primary site is NOT down?
• When I use my backup site, does it access information on my primary site?
• Is the XML API supported on my backup site?
• Is the Client API (SDK) supported on my backup site?
• Is my branding and customization information available on my backup site?
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• Are my customized pages available on my backup site?
• How is my backup site usage tracked?
• Will the teleconference number change if I am routed to my backup site from my primary site?

Note

These frequently asked questions apply only to administrators.

What is GSB? What is the name of my WebEx backup site?
GSB stands for Global Site Backup. WebEx's Global Site Backup (GSB) system ensures that you experience
business continuation even in a disaster situation. Additional benefits include full redundancy for maintenance
windows or other system outages. GSB provides each customer with a backup WebEx site. The GSB system
provides real-time, two-way database data synchronization between the primary site and the backup site. All
customers are supported with GSB.
Is a WebEx backup site a separate site from the primary site?
Yes, a backup site is a separate site from the primary site. WebEx hosts the backup site on a different system
and at a separate geographic location from the primary site.
Am I automatically redirected to my backup site when necessary?
Yes, the GSB system automatically redirects you to your backup site in the event of the entire meeting system
failure. If you started a meeting on your primary site and your primary site fails due to a whole system failure,
you are automatically routed to the same scheduled meeting on your backup site. In case of certain partial
system failures, WebEx will manually switch your service to the GSB site.
What are some typical instances in which my meeting will be routed to my backup site?
If the primary site fails before a scheduled meeting is started. The scheduled meeting is available on the backup
site, since meeting data is synchronized real time between the primary and the backup site. Meetings you
scheduled on the backup site will also be available when the primary site is back online again.
What happens if the primary site fails during the meeting?
If the primary site fails due to a whole system failure during a meeting, everyone -- including the host and
attendees -- is disconnected from the meeting. All meeting participants can rejoin the meeting using the primary
site URL, and they are automatically routed to the backup site. If the meeting collaboration servers still
function, you can continue the meeting on your primary site. However, you cannot start a new meeting on
your primary site. You can start a new meeting only on your backup site until the services on your primary
site are running again.
Can I access the meetings I scheduled on my primary site on my backup site?
With the GSB system, user account and meeting information are synchronized in real-time and in two ways
between the primary site and the backup site. You may access the meetings on your backup site only when
your primary site is not available.
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Can I create a new user account on my backup site and use the account on my primary site?
Yes. A user account created on the backup site will be replicated to the primary site in real time.
Can I schedule a meeting on my backup site and start the meeting on my primary site?
With the current GSB system, the answer is Yes. When you schedule a meeting on your backup site, that
meeting is replicated to your primary site instantly. Any meetings that you schedule on the backup site do
appear on your primary site.
When will maintenance be performed?
Communication will be sent out for any maintenance ahead of time, and the work will be done in our standard
maintenance windows, 7 p.m. (PST) to 12 a.m. (PST). During this time we will fail-over to the backup site,
and then fail-back after the maintenance has been complete, and there should not be any impact to the
availability of the service.
How do I know if I am on my backup site?
With the GSB system your backup site looks exactly that same as your primary site. You can identify which
site currently connected to by calling http://mycompany.webex.com/mycompany/detectbackup.php. If the
URL reaches the primary site, it returns a "Primary" message. If it reaches the GSB site, it returns a "Backup"
message.
How often is my primary site backed up? During what hours is the site backed up?
With the GSB system, your site data are synchronized between the primary site and the backup site in real
time and in a two-way fashion. If your primary site needs to be updated, WebEx performs the updates during
the normal maintenance window from 7 p.m. (PST) to 12 a.m. (PST). These maintenance updates on the
primary site are updated to the backup site instantly.
Can I use my backup site even if my primary site is NOT down?
With the GSB system, you may access only one site, either the primary site if it is up, or the backup site in
case the primary site is unavailable. The WebEx network automatically redirects the meeting requests to the
backup site in case the primary meeting system is down.
When I use my backup site, does it access information on my primary site?
Yes. When you start a meeting replicated from your primary site on the backup site, the meeting status (In
Progress/Join Now) will also be displayed for the original meeting on the primary site. Attendees can join the
meeting started on the backup site from the primary site.
Is the XML API supported on my backup site?
The XML API is supported on your backup site with GSB. With GSB there is no need to modify your
integration codes since the primary site and the backup site have the same URL.
Is the Client API (SDK) supported on my backup site?
Compared with current RUN Site’s support for API customers, the GSB API Support to partners offers many
more features. The RUN sites only have user accounts and branding information, while GSB Sites have many
more features supported as listed above. GSB also provides a way for API users to detect if they are accessing
the backup site by calling http://mycompany.webex.com/mycompany/detectbackup.php. If the URL reaches
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the primary site, it returns a "Primary" message. If it reaches the GSB site, it returns a "Backup" message.
RUN Sites did not provide any indication of Backup sites.
Is my branding and customization information available on my backup site?
In the GSB system, user account and meeting information are synchronized in real-time and in two ways
between the primary site and the backup site. The site branding information is replicated once a day from the
primary to the backup site only. Branding updates made on the backup site are not available on the primary
site.
Are my customized pages available on my backup site?
Yes. The GSB replication system replicates all customized pages and client versions from the primary site to
the backup site once a day. Customized pages and clients are usually available on the backup site after 24
hours.
How is my backup site usage tracked?
WebEx merges backup site usage with your corresponding primary sites. Reports on your primary site contain
both the primary site and backup site usage.
Will the teleconference number change if I am routed to my backup site from my primary site?
No. You shall use the same teleconference number on your backup site as on your primary site.
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General Questions
• What is UCF?
• What do I need in order to play rich media content files?
• How can I quickly get started using rich media content files?
• Can rich media content negatively impact my WebEx sessions or network capacity?
• Can I turn off the UCF rich media capabilities if I am concerned about bandwidth?

What is UCF?
UCF is a special file format you can use to display rich media files in WebEx sessions, as well as share any
type of document, including PowerPoint and Excel files. UCF files can contain the following types of rich
media content:
• WebEx WRF recordings (for more information about WRF files, see Recording and Playback, on page
43.
• Video
• Audio
• Flash files
• Web pages
• Third-party rich media content (through partner integration)
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The WebEx Universal Communications Toolkit contains a plugin for Microsoft PowerPoint that you can use
to create and share UCF files. In addition, the toolkit includes the WebEx Document Manager, which is an
offline viewer for UCF files
For more information about the toolkit, see the UCF Getting Started guide on the Support page of your WebEx
service site.
What do I need in order to play rich media content files?
Your computer should meet the following system requirements:
Windows
• Vista, 7, 8, 8.1
• Internet Explorer 7, 8, 9, 10, 11
• Adobe Flash player 11 or later (for Flash files)
• Windows Media Player 11 or later (for most audio and video files)
• QuickTime 7 or later (for QuickTime and other audio and video files not supported by Window Media
Player)
Macintosh
• Mac OS X 10.7 or later (Meeting Center only)
• QuickTime 7 or later (for QuickTime movies)
How can I quickly get started using rich media content files?
To make sure that your computer is properly set up, when you schedule a meeting, select the Request that
attendees verify rich media players option, and WebEx will ask your attendees to test their computers before
they join your session.
Can rich media content negatively impact my WebEx sessions or network capacity?
WebEx uses a variety of techniques to minimize the impact to WebEx sessions. Although sharing rich media
content can increase network utilization, under normal conditions, the impact to network traffic is negligible.
Can I turn off the UCF rich media capabilities if I am concerned about bandwidth?
Yes. Ask your WebEx site administrator to disable UCF rich media for your service site.

Working with UCF Files
• Can I share rich media content files during WebEx meetings?
• Can I record WebEx sessions that contain rich media content files?
• What is the difference between inserting files and using a URL? Which method do you recommend?
• What file formats supported for each media type?
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Can I share rich media content files during WebEx meetings?
Yes. Just make sure that all attendees have a media player installed on their computers; to prepare for a meeting
where you use rich media content files:
• Use the Advanced meeting scheduler and select Invite Attendees.
• On the Invite Attendees page, select the Request that attendees verify rich media players option. If
this option is selected, when your attendees join the session, they will be asked to test their systems to
make sure that they can play rich media files.
• On the Meeting Options page, select the Enable UCF rich media for attendees option.
• When you create your presentation, preview the slide presentation to ensure that the playback controls
are visible.
Can I record WebEx sessions that contain rich media content files?
Yes. To record the audio from UCF files at the same time that you record the audio from a teleconference,
use a telephone transmit and receive patch such as the DynaMetric TMP-636 or Plantronics MX-10. This
allows you to send the sound from your telephone through your computer sound card. To record video, make
sure to turn off hardware acceleration (or video overlay) on your computer video card. For details, see the
Windows Media Player online help.
What is the difference between inserting files and using a URL? Which method do you recommend?
Insert a URL to create a link to a file that is stored on a Web server or streaming server. When you insert a
file, you are including a file that is stored on your computer or another computer in your network.

Note

If you insert a rich media content file and want to send it to another person, you must also send the file;
"zipping" the presentation and the files together is an easy way to do this. If you use Document Manager
from the UCF Toolkit, you can save the rich media content inside the UCF file (called embedding) when
saving the UCF file. In this case, you need to send only the UCF file itself to the other person.

What file formats supported for each media type?
WebEx UCF supports these types of files:
Table 1: Supported File Types

Media type

Formats

Operating System

File extensions

Web pages

Any supported by Internet
Explorer, for example, HTML,
ASP, PHP

Windows

*.html, *.htm, *.asp,
*.php

WebEx recordings

WebEx WRF File

Windows

*.wrf
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Media type

Formats

Operating System

File extensions

Audio

Advanced Streaming Format
(ASF)

Windows

*.asf

Windows

*.wma

Windows Media Audio (WMA)

Windows

*.mp3

MPEG Audio Layer-3

Windows

*.mp2, *.mpv2

MPEG Audio Layer-2

Windows

*.mpa

MPEG Audio

Windows

*.mid, *.midi, *.rmi

Musical Instrument Digital
Interface (MIDI)

Windows

*.au

Windows

*.snd

Windows

*.wav

Windows

*.cda

Windows

*.aiff, *.aif, *.aifc

Advanced Streaming Format
(ASF)

Windows

*.asf

Windows

*.wmv

Windows Media Video (WMV)

Windows

*.avi

Audio Video Interleave (AVI)

Windows

UNIX Audio (AU)
Sound (SND)
Audio for Windows (WAV)
CD Audio (CDA)
Audio Interchange File Format
(AIFF)
Video

QuickTime movie

*.mpg, *.mpeg, *.m1v,
Mac OS, Windows *.mpe
*.mov, *.qt

Flash

Windows

MPEG

Flash

*swf

Known Issues and Workarounds
• What are the known issues of using rich media content files?
• Can I use UCF files on Macintosh, Solaris, or Linux computers?

What are the known issues of using rich media content files?
Here is a list of known issues:
• For WebEx recording, audio, and video files, when you select Pause, the recording does not always
pause at exactly the same place on all attendee computers.
• If you mute the audio in a UCF file, you also mute audio for all applications on your computer, except
on Windows Vista.
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• If you share a presentation that contains UCF files on a computer that has Microsoft Office XP SP1 or
SP2, and you have the Office XP macro security level set to "High" or "Medium", you will not be able
to import the PowerPoint presentation into a WebEx session.
• If you have problems viewing ASF files on computers with Windows Media Player 9, upgrade to the
latest version of Windows Media Player 9.
• Sharing QuickTime movies using the URL method requires QuickTime 6 or later.
• Animated images in GIF or PNG format display only the first image of the animation.
• Some types of images in StarOffice presentations may not appear.
• In PowerPoint, if you animate text by word or letter, a 10% delay occurs between words or letters,
regardless of the value that you set.
• In PowerPoint, if you choose the "Group text by paragraph" option, paragraph animations may appear
out of order.
• The PowerPoint chart animation "Group chart by unit" option is not supported.
• UCF does not support dimming general shapes such as charts, clip art pictures, 3D models, tables,
WordArt pictures, diagrams, and OLE objects.
• For general shapes, UCF does not support color change animations.
• The PowerPoint animation options for "Repeat until end of slide" and "Repeat until next click" are not
supported when you share presentations.
• If you share a presentation that was created using PowerPoint XP or later on a computer that is running
PowerPoint 2000, the first slide's master is used for all slides even if the slides have different masters.
• The quality of certain high resolution images in UCF media files may be degraded when you share
presentations.
• Shadows set with the PowerPoint Shadows Settings toolbar do not display during meetings, however
shadows created with the default shadow settings do appear.
• The following motion effects do not function as they do in PowerPoint slide show mode: Bounce Left,
Bounce Right, Curved Square, and Stairs Down.
• In presentations created using PowerPoint versions prior to PowerPoint 2003, transparent portions of
some images may be displayed as solid white regions.
• Animations in master slides are not supported.
• The PowerPoint "Change font animation" feature is not supported.
• Adobe Acrobat PDF custom fonts do not display; a default font displays instead.
• Fonts that are embedded into PowerPoint presentations are only displayed properly if the same font is
installed on the presenter's computer; otherwise the default font displays instead.
• WebEx Meeting Manager performance on a participant's computer can be impacted by playing Flash
files during a session.
• You cannot pause or stop interactive Flash files.
Can I use UCF files on Macintosh, Solaris, or Linux computers?
See Table 1: Supported File Types, on page 61.
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